
--~ 

:::0 
1'1"1 

(") "'T'I 
...... 0 1'1"1 

'o o ::o tDm 
~~~~z _, (") 
w. z 1'1"1 
r+O 
CD r+ (") 

0 
"'tJ 

[D -< _, 
0.---
CQ. 

"'tJ 
c: 

(") [D 
0 I 
'0 w 
'< ..... 

N ..... en 



I 

SubmitData 

User Manual 

May1995 

Lawrence Berkeley Laboratory 
University of California 

Berkeley, California 94720 

PUB-3126 



DISCLAIMER 

This document was prepared as an account of work sponsored by the United States 
Government. While this document is believed to contain correct information, neither the 
United States Government nor any agency thereof, nor the Regents of the University of 
California, nor any of their employees, makes any warranty, express or implied, or 
assumes any legal responsibility for the accuracy, completeness, or usefulness of any 
information, apparatus, product, or process disclosed, or represents that its use would not 
infringe privately owned rights. Reference herein to any specific commercial product, 
process, or service by its trade name, trademark, manufacturer, or otherwise, does not 
necessarily constitute or imply its endorsement, recommendation, or favoring by the 
United States Government or any agency thereof, or the Regents of the University of 
Califomia. The views and opinions of authors expressed herein do not necessarily state or 
reflect those of the United States Government or any agency thereof or the Regents of the 
University of Califomia. 

0 



/ 

SubmitData 

User Manual 

May1995 

Version 2.01 

Lawrence Berkeley Laboratory 
University of California 

Berkeley, California 94720 

Supported by the U.S. Deparhnent of Energy under Contract No. DE-AC03-76SF00098. 



DISCLAIMER 

This document was prepared as an account of work sponsored by the United States 
Govctllment While this document is believed to contain correct infonnation, neither 
the United States Government nor any agency thereof, nor The Regents of the 
University of California, nor any of their employees, malces any warranty, express or 
implied, or assumes any legal responsibility for the accuracy, completeness, or 
usefulness of any infonnation, apparatus, product, or process disclosed, or represents 
that its use would not infringe privately owned rights. Reference herein to any 
specific commercial product, process, or service by its uade name, trademark, 
manufacturer, or otherwise, does not necessarily constitute or imply its endorsement, 
recommendation, or favoring by the United States Government or any agency 
thereof, or The Regents of the University of California The views and opinions of 
authors expressed herein do not necessarily state or reflect those of the United States 
Government or any agency thereof, or The Regents of the University of California 

Lawrence Berkeley Laboratory is an equal opponunity employer. 

f 



Table of Contents 

, I 

Chapter 1. Introductio~ .............................................................................................. 1 
Overview ................................................................................................................ 1 
Version String ........................................................................................................ 2 
System Requirements ............................................................................................. 2 
Program Development ........................................................................................... 2 

Chapter 2. Installation ............................................................................................... 3 
Installing VisualWorks .......................................................................................... 3 
Installing SubmitData ............................................................................................. 3 

installing from a Distributed Image File .......................................................... .,3 
Installing from Distributed Source Files ........................................................... 3 

Working on Different Platforms ............................................................................ 4 
Field Menus ...................................................................................................... 4 
Window Menu .................................................................................................. 5 

Chapter 3. Sta.rting SubmitData ............................................................................... 7 
Opening the Launcher ............................................................................................ 7 
Opening a Database Module .................................................................................. 8 

Database Module Windows .............................................................................. 9 
Help .................................................................................................................... 9 

Opening the Transcript Window .......................................................................... 10 
Preferences ........................................................................................ ~.... ... .. ... .... .. 11 

Look Selection ...................................................................................... ; ......... 11 
Host Window System ..................................................................................... 11 

Smalltalk Utilities ..................................................................... ~ .......................... 12 
Quitting ................................................................................................................ 12 

Chapter 4. Preparing a Single Submission ........................................ ~ ................... 13 
Transaction Menu: Creating a New Transaction ................................................. 14 

Setting Pref~rences .......................................................................................... 14 
Opening a New Transaction ............................................................................ 14 

Filling in the Forms ............................................................................................... 15 
Mandatory and Optional Fields ................................................... 

7 
.................. 16 

iii 



Types of Fields .................................................................................................. 16 
Field Menus .................................................................................................... 17 
Subforms ......................................................................................................... 18 
Help with Fields .............................................................................................. 20 
Ending Data Entry ........................................................................................... 21 
Data Entry Errors ............................................................................................ 21 

Working with a Valid Transaction ....................................................................... 22 
File Menu ........................................................................................................ 22 
Saving a Transaction ....................................................................................... 22 
Printing a Transaction ..................................................................................... 22 
Viewing Transactions in the System Transcript ............................................. 23 
Submitting a Single Transaction ..................................................................... 23 
Installing a Transaction as a Template ............................................................ 23 
Clearing a Transaction .................................................................................... 23 

Chapter 5. Preparing Multiple Submissions ··················u····································· 25 
Creating a Template ............................................................................................. 25 

Specifying Variables ....................................................................................... 26 
Fields in the Variable Editor ........................................................................... 26 
Editing a Variable ........................................................................................... 28 
Ending Data Entry ........................................................................................... 29 

Installing the Template ........................................................................................ 29 
Editing a Template ............................................................................................... 29 
Defining a Batch Format ...................................................................................... 30 

Creating a Batch Format ................................................................................. 30 
Testing a Batch Format •.................................................................................. 33 

Using a Batch Format .......................................................................................... 34 
Making a Batch Submission ........................................................................... 34 
Making a Dialog Submission ......................................................................... .36 
Using Custom Batch Formats ......................................................................... 37 

Chapter 6. Additional Features .............................................................................. 39 
Editing a Saved Transaction ................................................................................ 39 
Submitting a Saved Transaction .......................................................................... 40 

Chapter 7. Database Modules ..................................... ~·····························~~············· 41 

SubmitData\GSDB ....................................................................................................... 43 
The GSDB Forms ................................................................................................ 43 
Loading AUTHORIN" Output .............................................................................. 44 
Upgrading Existing Templates ............................................................................ 44 

SubmitData\GDB ......................................................................................................... 45 
Submission Button ............................................................................................... 45 
Data Submission Forms ....................................................................................... 46 

Index .......................................................................................................................... 47 

iv 



' ! 

,~ 

I i 

Chapter 1 

Introduction 

Overview 

SubmitData is a convenient user interface that formats data for submission to pub­
lic databases; for example, the Genome Sequence database (GSDB) or the Genome 
database (GDB). 

When you fill in a database submission form in SubmitData, you work within 
one of the modules, generating a transaction that matches the particular require­
ments of that database. Transactions can be viewed, edited, printed, or stored for 
future use. _ 

SubmitData closely controls the accuracy of the data submission process. Each 
field is checked for data type, allowed ranges and controlled values, and the user 
is alerted to any problems. 

Submitting large amounts of related data is as easy as selecting a format and 
designating an input file with SubmitData' s template feature. In addition to one­
time submissions, users may create templates that can be merged with data files. 
Template variables are replaced by values in defined columns from the data file. 
Text files from many popular spreadsheet or database programs can be used with 
SubmitData. SubmitData \GSDB also accepts files generated by the AUTHORIN 
database submission tool. 

Three types of submissions are possible, depending on the user's requirements: 

• Direct submissions. 
• Batch submissions, in which templates are used to allow large amounts of 

data to be submitted in a single session. 
• Dialog submissions, in which data are submitted interactively. 

Once you have made a transaction, SubmitData lets you send it directly to the 
database through electronic mail. 
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SubmitData has been designed to readily adapt to changes in the submission 
proces.§ over time. As databases change their requirements, you will be able to up­
grade your copy of SubmitData to keep current. More database modules will also 
be made available, allowing you to expand the capabilities of the application. 

Version String 

The version string on your copy of SubmitData reflects the application version 
number in the first three digits and the database module version number in the last 
two digits. 

System Requirements 

The application's graphical user interface and its compatibility with multiple win­
dow systems make it convenient for a wide variety of users. SubmitData can adopt 
the look of any of these window systems. The program consists of a Smalltalk im­
age file (the application) with one or more database modules installed. Each mod­
ule contains settings for a single database. 

To run SubmitData, your computer must be able to run ParcPlace© Visual­
Works 1.0, which is available for UNIX (Sun OS, Solaris, HP /UX, AIX, or OSF), Mi­
crosoft Windows, OS/2, or Macintosh operating systems. At least 5MB of free disk 
space and 8 MB of RAM is recommended. For more information, see the installa­
tion notes that came with your copy of SubmitData. 

Program Development 

This program has been developed with support from the U.S. Department of En­
ergy by 
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Manfred D. Zorn 
Software Technologies and Applications Group 
Lawrence Berkeley Laboratory 
E-mail: SubmitData@lbl.gov 

Technical writing by Annette Greiner and David Hand 
Technical and Electronic Information Department 
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Chapter 2 

Installation 

Installing VisualWorks 

To run SubmitData, you must have VisualWorks installed on your computer. 
Refer to the installation instructions provided with your copy of ParcPlace \ 
VisualWorks 1.0. After installation you will have a file called st80 on your hard 
disk. 

Installing SubmitData 

SubmitData is distributed in one of two ways: as an image file or as a set of source 
files. Refer to the installation instructions that were provided with the software 
distribution for further details and to select the installation method. 

Installing from a Distributed Image File 

Copy the i.n;tage file, a file named Submi tDa ta or Submi tDa ta . im, to your hard 
disk. Save a backup copy of the image in a separate place. 

Installing from Distributed Source Files 

SubmitData can be installed from distributed source files by executing an installa­
tion script into a running Small talk image. 

The database module files are parts of the program that control data input for 
a specific genetic database. These files are designated by the names of the databas­
es (GSDB, for example). Use the installer program to install each module on your 
hard disk. · · 

When you install the first one, the SubmitData image file will be created. For 
details, refer to the installation notes that came with your distribution. 
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Working on Different Platforms 

SubmitData is implemented in ParcPlace VisualWorks 1.0 and runs on a UNIX 
(Sun OS, Solaris, HP /UX, AIX, or OSF), Microsoft Windows, OS/2, or Macintosh 
operating system. Because Small talk's graphical interface is the same for all four 
types of systems, most of the instructions in this manual apply to all types of users. 
Mouse commands, however, differ according to the type of mouse you use. Table 
2-1. shows how to issue mouse commands. 

Table 2-1. Mouse commands 

Mouse Type To Select To Pull Down a To Pull Down a 
Field Menu Window Menu 

Single-button click option-dick command-dick 
(most Macintosh 
systems) 

Double-button click left button click right button control-dick 
(most MS Win- right button 
dows-based sys-
terns) 

Triple-button click left button click middle click right button 
(most UNIX- button 
based systems 

Before you begin using SubmitData, you will need to understand the general 
techniques for using your operating system. Make sure that you know how to 
open and close applications, manipulate windows and files, and use the mouse. 
See your operating system manual if you need information about these basic pro­
cedures. 

Field Menus 

Most fields in the SubmitData application have an associated menu. When you 
pull down the menu, you will see options for entering data into the field or for pro­
gramming a variable. For details about using the field menus, see "Filling in the 
Forms" in Chapter 4. For information about variables and templates, see "Creating 
a Template" in Chapter 5. 
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Window Menu 

relabel as ... 

refresh 
moue 

collapse 

close 

Figure 2-1. Window menu. 

The Window menu (Figure 2-1.) lists options for manipulating the currently active 
window. 

Relabel as ... 
This option lets you give the window a new name by typing the name in a di­
alog box. Changing SubmitData's window names is not recommended. 

Refresh 
Choosing this option causes the contents of the window to be redrawn. 

Move 
Selecting Move allows you to relocate the entire window by moving the mouse 
pointer and clicking in the desired location. 

Resize 
Resizing lets you change a window's size and shape. The upper left comer re­
mains anchored to its original position, and the lower right comer moves with 
the mouse pointer. Select Resize and move the mouse pointer to a position on 
the screen. Click there, and the window resizes to that position. 

Front or Back 
Selecting Front moves the active window to the front layer of the screen; choos­
ing Back sends it to the back layer. 

5 



Collapse 
This shrinks the window down to the size of a small title bar or icon (depending 
on the window system you use), giving you more room to work with other 
windows. 

Close 
This option closes the window entirely. 

Note: Closing the main window will quit the application. 
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Chapter 3 

Starting SubmitData 
\ 

Opening the Launcher 

To start SubmitData, open the Smalltalk program (st80) and the SubmitData im­
age file as you normally would any application and file on your system. 

On UNIX, make sure that the application program ( s t 8 0) is in your command 
search path (i.e., $PATH «variable») and type 

st80 SubmitData.im 

With Macintosh or Windows, 

double-click on the SubmitData icon. 

The ObjectWorks logo appears on the screen while Smalltalk is being loaded. 
The first SubmitData window is the launcher (Figure 3-1.). From the launcher 

window, you can choose a database module to work with, you can set preferences, 
or you can quit the application. 

J 
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SubmitData\DB 

~-~~ S ubmitData\DB 

Genome Sequence DB (GS DB) 
Genome Data Base (GDB) 
Transcript 
Preferences 
Utilities > 
au it __ _ 

Figure 3-1. SubmitData launcher window. 

Opening a Database Module 

SubmitData has separate modules for the forms required by various databases. 
The names of the installed modules are the first items listed in the launcher win­
dow (Figure 3-1.). Click on one of these to open the Database Module Window 
(Figure 3-2.) and to start filling out the forms that correspond to that database. 

D SubmitData \GSDB 

SubmitData\G SOB 
Version 2.00.20 

Softv.lare Technologies and Applications Group 
LaVYrence Berkeley Laboratory 

Copyright@ 1993-1995 The Regents of the University of California. 
All rights reserved. 

I Transactiol'l" [ a uit ] _ [ Help ] 

Figure 3-2. GSDB module window. 
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Database Module Windows 

This window has three buttons: Transaction (in SubmitData \GSDB) or Submission 
(in SubmitData \GDB), Quit and Help. Transaction (or Submission) opens a menu 
from which you can begin working in the module. Quit closes the module and re­
turns you to the launcher. Help opens the general on-line help menu for SubmitDa­
ta. i 

Help 

You can get on-line help by clicking on the Help button at the bottom of the module 
window. This button opens a two-part Help window (Figure 3-3.). Select a topic 
from a list in the upper part of the window. The lower part of the window displays 
help information for the selected topic. When you have finished ~ooking at the help 
text, cliek on Close to return to the window from which you entered the help sys­
tem. 

2 Transaction Menu 
3 Entity Help 

5 Batch operations 

SubmitData\G SOB 

SubmitData\GSDB Help 
Select from the list of topics: 

A program to create and edit data for electronic submission to the 
GSDB sequence database. GSDB accepts data in the form of . 
/ta!Js.:~c.1J!>IJS. This program allows you to create· ba!J.o:;,:.:Jc:ti<.>!J ... ior a new 
GSDB Entry and to modify tr...:JtJs.:~c:tk>!Jsstored as templates. It· 
provides a number of functions to save, print, and submit a 
baiJ.'ii:U.1if.>l1 A template can be merged with actual data either 
interactively or from a tab-delimited file. A l!a/J.'i.:.:Jdif.>!Jis checked for 
consistency with the appropriate definitions for allowed field types and 
vocabularies for field values. 

Figure 3-3. Help window for SubmitData \GSDB. 
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Opening the Transcript Window 

The first time you open SubmitData, the System Transcript window (Figure 3-4.) 
appears beside the launcher. This window displays error messages, warnings, and 
other informational messages. You can also review a submission in the transcript 
window (see "Viewing Transactions in the System Transcript" in Chapter 4). 

The window must be open for the transcripts to be recorded. Closing the win­
dow clears the transcript. To open it again, click on Transcript in the launcher. 

10 

_o System Transr:::ript 

S ubEntity: Submitter is MANDA TORY and must be specified to 
continue! 

Figure 3-4. System Transcript window. 
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Preferences 

You c'an set the look of SubmitData' s wmdows to match the window system with 
which you are most comfortable. Click on Preferences in the launcher to see the op­
tions (Figure 3-5.). 

Look Selection 

This option sets the look of SubmitData. Choosing Default Look from the pull-down 
menu gives you the look of Small talk. If you choose Auto Select, the application will 
select a look based on your operating system. Clicking in the check box causes the 
basic tools (the launcher and the system transcript) to also adopt the selected look. 
Windows that are already open, such as the Preferences window, must be closed 
and opened again to show the changes. 

Host Window System 

This option allows you to set th~ host window system. When you choose Auto 
Select from the pull down menu, the window system is set to the one you are cur­
rently running on your computer. 

0 Look Preferences BJ 

,... Look Selection 

!Macintosh ~I 

181 Basic Tools Hdopt Look 

- Host. Window System 

I nuto Select ~I 

' 

Figure 3~5. Preferences window. 
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Smalltalk Utilities 

The Utilities button opens a menu of Smalltalk utilities. You will not need to use 
this menu in your everyday work; however, these utilities are important for updat­
ing SubmitData or for installing new database modules. 

Quitting 

Clicking on Quit in the launcher opens a small dialog box (Figure 3-6.) that gives 
you the following options: 

• Choose Quit to quit SubmitData. If you have created templates or batch for­
mats that still need to be saved, SubmitData will remind you of this when 
you click on Quit. 

• Choose Save then Quit, to save all your changes before the application closes. 
You may also use this option to save an incomplete transaction. 

• Choose Cancel if you do not want to quit. 

When you save, you are actually saving the entire SubmitData application. A 
dialog box will prompt you to enter a name for the file. (The default file name is 
"SubmitData".) Press return to save without changing the default file name. The 
application is sa:ved into the same directory or folder where you started it. 

n Quit D 

( Saue then Quit) 

( Cancel ) 

Figure 3-6. Quit dialog box. 
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Chapter 4 

Preparing a Single 

Submission 

Use the following quick procedure to prepare and 
submit a single valid transac~ion to a database: 

1. Open SubmitData. 

2. Select the desired database module in the launcher. 

3. Pull down the Transaction menu and select New transaction. 

4. Fill out all the forms for the transaction with actual data. 

5. Pull down the File menu in the database module window, 
and select Submit to database ... 

0 

To make a single submission, you must create a valid transaction (a prepared 
submission) that contains the data you wish to send. You may create a transaction 
by opening the appropriate database module and filling in the appropriate fields. 

Once you have a valid transaction, you can submit your data in one step. You 
can also view and print your data, or turn the transaction into a template for mak­
ing multiple submissions. For details about multiple submissions, see Chapter 5. 

13 
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Transaction Menu: Creating a New Transaction 

_ Clicking on the Transaction button in a module window opens a menu (Figure 
4-1.) with options for handling transactions. 

Transactiorr 

New transaction 
Edit template ... 

Batch 
Load 

Preferences ... 

l> 
l> 

Figure 4-1. Transaction menu. 

Setting Preferences 

Selecting Preferences from the Transaction menu opens the Preferences dialog box. 
The option Show empty fields lets you specify whether or not blank fields are kept 
as part of the transaction. The default specification depends on the database mod­
ule. With this setting turned on, you will see the names of all the fields in the form 
(whether you entered values for them or not) when you view a transaction. Chang­
es to this setting must be made before you create the new transaction. If the option 
is turned off, only fields with values are shown while editing a template. 

Opening a New Transaction 

You may create a new transaction by selecting the first option on the Transaction 
menu: New transaction. This opens the module's form window (Figure 4-2.) so that 
you can begin entering your data. 

14 



Filling in the Forms 

Featocc _ 

Sequence:subform Featocc ~ Q 

c urrentForm 
feat desc • 
left start 0 ---- -- Parent Form 

right start 0 

left end 0 

right end 0 ', 

operator Select an operator: ..... Menu 

comp strand OYes ONo 

experimental OYes ONo 

complete 5 0Yes ONo 
Radio Buttons 

complete 3 OYes ONo 

codon start I Select a codon start: .... I Scroll Bar 
isconsensus OYes ONo 

replace I 
featk:ey featk:ey JK> Subform Button 

Fill in at least the mandatory (bold) fields and press OK. Status Line 

8 [ Cancel ] ~ . 

Figure 4-2. A sample form. 

Each database module contains hierarchical forms and subforms that relate to the 
type of submission that you are making. The subforms can be reached by selecting 
special buttons on the forms. 

The information in all the forms and subforms needed for a valid submission 
constitutes a '~transaction". Enter your data into the forms by typing in the fields 
or selecting from available choices. 

At the top of every form or subform is a header that shows the name of the par­
ent form (if it has one), a colon, and the form's name. The majority of the form is 
devoted to fields for data entry~ Every field has a label on the left and an input field 
for values on the right. You can move from field to field (top to bottom) by pressing 
the tab key. You can also click on any input field to make it active. 
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Just below the fields is a status line, and at the bottom is a line of buttons. Cancel 
closes the current form or subform without accepting any chan.ges, Help opens the 
on-line help menu, and OK accepts the changes and closes the form. The OK button 
is the default. 

Mandatory and Optional Fields 

Some fields must be filled in to make a valid transaction. The names of mandatory 
fields are indicated in bold lettering. If you forget to enter a value for a mandatory 
field, SubmitData will prompt you to do so before it accepts the form as completed. 

If a button appears in a mandatory field, you must complete all the mandatory 
fields in the subform to which it leads. If the button occurs in an optional field, you 
need not complete any of the mandatory fields in the subform. If you want to fill 
in any of the fields in an optional subform, however, you will need to complete all 
the mandatory fields in it. 

Types of Fields 

As you enter data in the forms, you will find several types of fields. 

Single-Line Input Fields 

16 

Single-line input fields hold one line of text or numbers. They will not accept a 
carriage return. (A carriage return will trigger the default button at the bottom 
of the form.) When a field of this type is active, a small cursor appears in it. 
Most fields require a string value and will accept alphanumeric characters and 
a few other special characters (i.e.,$,&,+, etc.). Some input fields have other 
specific data types, which are qescribed in the label of the field menu. 

• Numbers 
Numeric fields accept only digits and may have a default value of zero. 
Some of these, however, require a value greater than zero. For example, 
"page start" and "page end" must be positive numbers to be valid. In such 
cases SubmitData will not accept zero values, even if they are in an optional 
field. You may delete the zeroes or enter positive numbers., 

• Dates 
Date fields require a date in one of the following formats: 

30 April1982 
30-APR-82 

April30, 1982 
4/30/82 

Any date entered will be converted to a standard format. 

• Phone numbers 
Phone number fields will only accept digits, spaces, hyphens, parentheses, 
slashes, and plus signs. 



Multi-line Text Fields 
Fields with scroll bars are multi-line text fields. These fields do accept carriage 
returns. The number of lines they can hold is limited only by the amount of 
available memory. 

Menu Fields 
Menu fields have the appearance and functionality of a standard menu field in 
the chosen window system. Rather than entering a text string, you select a val­
ue from a controlled list of values. 

Radio Buttons 
Certain fields consist of pair of radio buttons, one for "yes" and one for "no." 
These radio buttons do not have associated menus. · 

Subform Buttons 
Some fields are shaped like buttons. If you select one of these, a sub form opens 
in a new window. 

Automatic Fields 
No data input is possible for automatic fields. SubmitData will automatically 
generate an appropriate value. 

Field Menus 

Most fields have an attached menu. These let you select from a list of entry options. 

Menu Labels 
The first selection on any field menu is a menu label, which gives a brief de­
scription of the field and the type of values allowed. Selecting it will clear the 
field. 

Cut, Copy, and Paste 
Selecting Cut from a field menu deletes the information selected in the field and 
puts it on the clipboard for future use. Choosing Copy also places the informa­
tion on the clipboard but does not delete it. Selecting Paste places the contents 
of the clipboard into the active field. 

Read from Data File ... 
This option reads the contents of a data file into the field. When you select it, 
SubmitData asks for the name of the file. Type in the name and click on OK. The 
text in the file will immediately appear in the field. 

Define a Variable 
For information about defining variables, see "Specifying Variables" in Chapter 
5. 

17 
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Cancel and Accept 
Some text entry fields have these two options. Choosing Cancel cancels the last 
change you made to the field value. Choosing Accept accepts the changes to the 
current field. 

Short-Cut Menu Items 
The menus for some single-line input fields provide shortcuts for entering com­
mon values. For example, in date fields you can select Today's Date to enter the 
current date. Shortcuts save typing time and prevent data entry errors. 

Sub forms 

Navigating 
Forms may contain many layers of subforms. To help you keep track of where 
you are, the upper left corner of each subform shows the name of the form or 
subform from which you reached it (the "parent" form). A colon follows the 
name of the parent form, and the name of the sub form follows the colon. If you 
are filling out a sub form called "Person" that you opened from the "Reference" 
subform, this header will display: "Reference: subform Person". For top-level 
forms, the word "Form" appears before the colon (Figure 4-2.). 

Modifying Subform Entries 

18 

A subform menu (Figure 4-3.) will appear if there are already~xisting sub­
forms that you have created previously. This menu presents a list of the present 
sub forms and shows the sub forms numbered and identified by field values. Se­
lect Cancel to abort adding a subform, or new ... to create an entirely new sub­
form. The subform menu helps you keep track of which subform entries you 
will keep as part of the submission. The subforms attached to the form are enu­
merated at the top of the menu. 

Please choose an existing person: 

1. Smith 
2. Thompson 

cancel 
new person 

Figure 4-3. Subform menu. 



• Multiple Subforms 
You can easily fill out multiple subforms with SubmitData. You might do 
this, for example, if you want to cite three authors for a reference. Submit­
Data lets you fill in three-person subforms quickly. 

1. Click on the Person button to open the subform menu. Fill'in the form for 
the first person. 

2. Click on OK. The sub form window closes, and you are back to the parent 
form. 

3. CHck on the Person button again to open the subform menu. 
4. Click on the line that represents the first author. · 
5. In the window that opens, make the changes for the second person. The 

button line at the bottom of the window will be different from the origi­
nal one (Figure 4-4.). It will have New, Edit, and Delete buttons. 

6. Click on New to add the edited subform to the submission as a new per­
son form. 

You can also make an additional sub form entry from scratch. If you click on 
new person in the sub form menu, an empty Person sub form will open. Com­
plete it and click OK to enter entirely new information for the new person. 

Figure 4-4. Button Hne when editing a subform. 

• Editing Subforms 
You may use the sub form menu to change or delete completed subforms. 
Click on the line that represents the entry you want to alter. When the win­
dow for that entry opens, make your changes and click on Edit to accept the 
alterations and store the subform in lieu of the old subform. 

• Deleting Subform Entries 
To delete a subform entry, click on Delete. If you decide not to change the 
information after all, click on Cancel. · 
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Help with Fields 

As you work in the form and subform windows, you have access to on-line help 
about the fields in a particular window. Clicking on the Help button opens a menu 
(Figure 4-5.) listing the fields on a form. This menu also lets you open the Help 
window. If you choose one of the fields, you will see the field name, its type, and 
descriptions of the field's purpose (Figure 4-6.). For fields that have entry restric­
tions, you will also see allowed values and ranges. 
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Click on OK to close the Help window. 
Note: You cannot edit forms while the Help window is open. 

comment 
definition 
diuision 
keyword 
locus_name 
molecule_type 
reference 
segments 
segment_number 
sequence 

General help 
cancel 

Figure 4-5. Help menu. 
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Field: definition ~ 
Description: Topology of the molecule that was sequenced. This 
infonnation appears in the locus line of the flatfile. 
Data type: Sb"ing 
Value range: "linear·. "circular·. 
Length: ·1 o-

Field is Mandatory_ 

{7 

Figure 4-6. Help text for a field. 

Ending Data Entry 

As you finish filling in the fields for each form or subform, click on OK. When you 
select OK from the top-level form, the transaction will be complete. SubmitData 
will prompt you to finish entering data if you have not filled in all the mandatory 
fields. You will know that the transaction is valid when the application accepts it 
with no warning messages. , " 

A File button appears in the database module window. 

Data Entry Errors 

Most of SubmitData's form fields contain at least one field that requires data of a 
specific type. Failure to enter any data or the correct type of data in these fields 
(e.g., entering letters in a field that requires digits) will result in an error message . 

To clear such messages, enter data of the required form and proceed. 
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Working with a Valid Transaction 

File Menu 

The File menu button (Figure 4-7.) appears in the database module window after a 
valid transaction has been created. File menu options are useful for sending in sub­
missions, saving files, viewing or printing your data, and working with templates. 
These options are available only while a valid transaction is current in the applica­
tion. 

File ,.. 

Saue transaction to file ... 
Print transaction 
Show in system transcript 

Submit to database ... 
Install transaction as template ... 

Clear transaction 

Figure 4-7. File menu. 

Saving a Transaction 

Select Save transaction to file ... to save the current transaction in a file on your hard 
disk. A small dialog box will open, allowing you to enter a file name for the trans­
action. You can later submit a saved transaction (see Chapter 6 for more informa­
tion). 

Printing a Transaction · 

You can print a listing of all the entries in the current transaction in the format ac­
cepted by the database by choosing Print transaction from the file menu. The cur­
rent transaction is transcribed into PostScript and sent to the printer. 
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Viewing Transactions in the System Transcript 

Select Show in system transcript to review the current transaction, and the transac­
tion will be displayed in the System Transcript window in a format accepted by the 
database. (Make sure that the Transcript window is open. If it isn't, bring Submit­
Data's launcher to the front and click on System Transcript. Then return to the da­
tabase module window.) 

Submitting a Single Transaction 

Select Submit to database ... if you are ready to send the current transaction to the da­
tabase. We recommend that you review the transaction by printing it or by view­
ing it in the system transcript window before you send it. 

When you are satisfied that the data are correct, pull down the File menu and 
select. Submit to database .... You will be asked to verify that you do indeed wish to 
submit the data. The information will be sent to the database automatically. 

Installing a Transaction as a Template 

To make any kind of batch submission, you must first install a transaction as a tem­
plate. A template is a special kind of transaction that has variables defined for field 
values. You can make a transaction into a template by selecting Install new template 

/ from the File menu. (For more information about templates, see Chapter 5.) 

Clearing a Transaction 

Select Clear transaction to start over on a new transaction. This clears the current 
transaction and resets the program. If you did not save the current transaction file, 
the information in it will be lost when you clear it. A warning dialog will ask for a 
confirmation in case you did not save or install the transaction. 
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Chapter 5 

Preparing Multiple 

Submissions 

The real strength of SubmitData lies in its efficiency for making multiple submis­
sions. Through the use of templates, you can submit several transactions in little 
more time than it takes to submit one. Templates save you the trouble of entering 
duplicate data into more than one transaction. To build multiple submissions, you 
will need a template and a batch format. 

A template is a transaction that has some fields programmed as variables. The 
template specifies the data that all the transactions share; the remaining changing 
information is either extracted from a data file (batch submission) or the user is 
prompted for it (dialog submission). A batch format tells SubmitDatahow to 
merge the data. 

In a batch submission, a text file containing tab-delimited rows of data is im­
ported. Each row holds the data for one transaction. When merging the data file 
with a template, SubmitData gathers the information in the columns you specified, 
builds transactions, and sends it to the appropriate database. , 

In a dialog submission, the user is prompted to provide values for all the vari­
ables. The dialog can be generated from the field name or supplied by user 
(prompt text in variable definition). \ 

Creating a Template 

Since templates are just a special kind of transaction, you create them in the same 
way as you would create a normal transaction. The only difference is that you in~ 
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sert one or more variables in the data fields. For values that will be the same for all 
the transactions you plan to make with the template, you enter the value in the 
form as usual. For variable values, enter the appropriate variable. (If you do not 
know how to make a transaction, refer to the "Transaction Menu: Creating a New 
Transaction" and "Filling in the Forms" sections in Chapter 4.) 

Specifying Variables 

To enter a variable in a transaction, pull down the field menu for the field in which 
you want to enter it. Select the Define a variable option (Figure 5-1.). The Variable 
Editor (Figure 5-2.) will open. The Select a variable type menu shows a list of the 
types of variables. Select one that meets your needs. 

Enter a locus name: 

copy 
cut 
paste 

Define a uariable 

Figure 5-1. The menu for a text entry field. 

Fields in the Variable Editor 

SubmitData templates can accept seven different kinds of variables. Most of these 
can have a variable name, a column number, a default value, and a prompt text. 
The column number refers to a column in the data file for batch submissions. You 
need not define column numbers when you fill in the variables, although it is rec­
ommended. (This can also be done when you create a batch format.) Name all vari­
ables: this makes it easier to keep track of your variables and allows you to reuse 
them. Naming variables allows you to enter multiple variables in one field. The 
values in the "default" and "prompt text" fields are used to construct the dialog 
(Figure 5-7.) during a dialog submission. 
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Variable Types 

Uariable Editor Uariable Editor 

Select a uariable type: 

Column uariable 
Reference ua.riable 
Session uariable 
Filename uariable 
Dialog uariable 
Reuse uariable 
Procedure uariable 

Figure 5-2. Variable editor. 

• Column Variables 
Selecting a column variable tells the application to read data from a column 
in a data file. In dialog submissions, SubmitData treats column variables as 
if they were dialog variables. The prompt text default for the "Column" 
field is "0". 

• Reference Variables 
A reference variable is one that takes itS'value from another field. The refer­
enced field can be any other field (e.g., variable, automatic, constant). You 
select the form and specify the field in the form from the pull-down menus. 
The prompt text default for the "Form" field is the name of the current form. 

• Session Variables 
With a session variable, you can specify a value that will be the same for all 
the transactions in a submission session. Session variables are constant for 
one batch or dialog submission. At the beginning of the submission run, 
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SubmitData will prompt you to enter the value for the session variable. 
There is no prompt text default. 

• .Filename Variables 
If you choose a filename variable, Submit Data will interpret text in a col­
umn of the data file as a file name rather than as data. The entire contents of 
the named file will be read and will become the field value. In dialog sub­
missions, SubmitData prompts you for the file name. The prompt text de­
fault for the "Column" field is "0". 

• Dialog Variables 
Dialog variables let you enter a new value for each record interactively, 
even in a batch submission. Using a dialog variable tells SubmitData to 
prompt you for the values when you make a submission. There is no 
prompt text default. 

• Reuse Variables 
With this option, you can reuse a named variable of any other type. The val­
ue of a variable is set dependent on its original type (e.g., from a column for 
a column variable; by the user for a dialog variable). Select the variable from 
a list of names on the pull down menu. The prompt text default for the 
"Variable name" field is whatever variable has been defined. 

• Procedure Variables 
Procedure variables calculate the value for a variable using predefined pro­
cedures. For example, you can insert the date on the day you run the batch 
submission by selecting the Today's Date procedure. The number and kind 
of predefined procedure may vary for different database modules. There is 
no prompt text default. 

Using Multiple Variables 
As long as you name your variables, you can use more than one in a field. Sim­
ply specify the first variable, close the Variable Editor, open it again, and spec­
ify the next variable. If you like, you can also use fixed text that will appear 
along with the variables. Type the fixed text and specify your variables in the 
order in which you want them to appear. Be careful not to delete or alter the 
variable definitions. 

Editing a Variable 

Select the variable definition (i.e., text between and including « ») and open the 
Variable Editor. If there is only a single variable offered in the field, you may select 
the entire contents of the field and open the Variable Editor. 
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Ending Data Entry 

As with a regular transaction, you finish creating a template by selecting OK from 
the top-level form. SubmitData will prompt you to finish entering data if you have 
not filled in all the mandatory fields. The File button also appears in the database 
module window. Through the File menu, you can view or print the new template 
or save it as a file. 

Installing the Template 

You can use any transaction that has variables defined as a template. To install the 
current transaction as a template, click on the File button and select Install transac­
tion as template ... This adds the template to the list in the Edit Template menu, but 
it does not save it as part of the application. You must choose Save then Quit when 
you quit SubmitData for the new template to be saved. Once you have installed the 
template, choose Clear transaction from the File menu. This will restore the Trans­
action menu. 

Editing a Template 

You can edit an installed template by selecting Edit Template ... from the Transaction 
menu. The procedure is as follows: 

1. When you make this selection, a menu listing the existing templates will 
appear. Select the one that you want to make changes to. 

2. Once you make a selection, SubmitData checks the template for syntactic 
errors and displays it in a new window. You can make any alterations 
you like by filling in the changes in the forms. If Show empty fields is 
turned off in Preferences, however, you will only see the fields that al­
ready contain values. To see and add new values to fields that do not 
have values, select Show empty fields in the Preferences window before 
starting to edit the template. 

3. When you are done, select OK on the top-level form. The File button ap­
pears in the module window. To save your changes, you must install the 
template again. 

4. Pull down the File menu and select Install transaction as template .... You 
can install it under a new name to make a new template based on the old 
one, or you can install it under the original name to replace the old one. 
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Defining a Batch Format 

Once you have installed a template, you can pair it with a data file to make a batch 
submission. You set up this pairing by defining a batch format. The batch format 
tells SubmitData which columns of the data file match up with fields in the tem­
plate. If you are making a dialog submission, you will still need to make a batch 
format. It will tell SubmitData which template to use and prepare it to accept user 
input. 

Creating a Batch Format 

To create a batch format, the procedure is as follows: 
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1. Pull down the Transaction menu and select Batch. Then select Define 
batch format from the submenu (Figure 5-3.). The SubmitData\Batch 
window opens (Figure 5-4.). 

2. Near the top is a pull-down menu listing the available templates. The 
"Batch format name" field menu lists already-installed batch formats. 
When you select any of these, a list of the column variables in that tem­
plate appears in the middle of the window (Figure 5-S.).It shows the 
name of the form, the name of each field, and the column number and 
name of each variable (if you specified these last two in the template). If 
you already specified the column number when you defined the column 
variable, this list can serve as a summary overview of the columns and 
variables. 

Define batch format 

Run batch submission .. . 
Run dialog submission .. . 

Figure 5-3. Batch submenu. 
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D SubmitData \Batch 0 

Define a Batch Fonnat . 
. Select from the menu of templates and 

specify a TAB delimited column for each variable: 

Select a T emplate:l ... I 
Form name Field name Column Name 

~ 

~ 

-

{} 
¢1 1¢ 

Enter column number: I ol 
Batch tonnat ~ame:l I 

0 [cancel] ~ 

Figure 5-4. SubmitData \Batch window. 

Batch Formats for Batch Submissions 
For batch submissions, you must specify a column number for every column 
variable unless you already assigned a column number when you defined the 
variable. 
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1. Click on a line in the table to select that variable, then type the number 
of the column in the data file that corresponds to it. 

2. The number appears in the "Enter column number" field below. Now 
press return or select another row in the table. The column number in the 
list changes to match the number you just typed. 

3. Continue down the list until you have assigned a column number for 
each column variable in the template (Figure 5-5.). 

4. Next, type a name for the batch format and click on OK. A message will 
appear to tell you that the new batch format has been added to the list of 
available batch formats and different buttons appear on the bottom of 
the window. 

D SubmitData \Batch 

Define a Batch Fonnat 
Select from the menu of templates and 

specify a TAB delimited column for each variable: 

Select a T emplate:l bad DOG ~I 
Fo1111 name Field name Column Name 

Enter column number: I 
Batch format name: I DO Gfo1111. 

Figure 5-5. SubmitData \Batch window with a format loaded. 



Batch Formats for Dialog Submissions 
When you make a batch format for a dialog submission, you need not enter any 
column information. If you are using a template that has column variables, the 
information about these variables will appear in the SubmitData \Batch win­
dow. Since a dialog submission does not use a data file, however, the column 
numbers will have no effect on your submission, and SubmitData will ignore 
them. 

1. Choose the correct template and specify a name for the batch format. 
When you are finished, click on OK. 

2. A message will appear to tell you that the new batch format has been 
added to the list of available batch formats. Because SubmitData can ig­
nore column designations in dialog submissions, you can use the same 
batch format to make a dialog as well as batch submission. If you plan to 
take advantage of this flexibility, make sure you fill in the column num­
bers in the batch format. 

Editing Batch Formats 
Once your new batch format has been created, new buttons appear in the defi­
nition window. You can alter the batch format by making changes and clicking 
on Edit. If you want to remove a batch format, select Delete. You can also edit 
other batch formats by selecting them from the "Batch format name" field 
menu. If you want to close the SubmitData \Batch window without making 
further changes, choose Quit. SubmitData will ask whether you w~t to save 
the new batch format. Before you quit, however, you should test the batch for­
mat with the corresponding data file. 

Testing a Batch Format 

You use the Test button in the SubmitData \Batch window to test a new format 
whenever you create one. 

1. When you select Test, SubmitData asks you for the name of the data file. 
Type it in and click on OK. (You may use an asterisk as a "wild card" 
character to get a list, of file names with the text you remember. For ex­
ample, typing *.txt will bring up a list of files with the txt extension.) 

2. Next, the program asks you to name a new file that will contain the re­
sults of the test submission. Type a new name or leave the default file 
name, and click on OK again. SubmitData then reads the first row of data 
from the data file and applies it to the template according to the instruc­
tions in the batch format. It shows you the results for this first transac­
tion in a new Batch Transcript window. 

3. Scroll through the text of the transcript to see that the field values make 
sense, then close the window. SubmitData returns you to the 
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SubmitData \Batch window. Here you can edit the batch format, delete 
it, or return to the database dialog box. If you want to accept the batch 
format without further changes, click on Quit. SubmitData will prompt 
you to save the batch format. 

Using a Batch Format 

Making a Batch Submission 

In a batch submission, you merge a template with a data file according to the in­
structions in a batch format. So, once you've defined the template and the batch 
format, the only remaining preparation is to create the data file. 

The Data File 
The data file holds the information that will be transferred into multiple trans­
actions by the batch submission process. It must be a tab-delimited text file 
with a carriage return after each row of data. Text files generated by most 
spreadsheet or database programs are tab-delimited. In general, if your spread­
sheet or database program allows you to save files as text, those text files will 
likely be compatible with SubmitData. 

Even with a simple text editor, you can easily make a compatible data file. Type 
yo~r data in rows with a tab after each entry and a carriage return after every 
row. Each row in the data file must contain the variable data for one transac­
tion. For each field in the submission form that contains a column variable, 
there must be a corresponding column in the data file. When you enter your 
data as straight text, the columns probably will not line up. Do not try to align 
them; the number of tabs before a given value, not the visual alignment, defines 
the column. 

Running a Batch Submission 
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If you have a data file, a template, and a tested batch format, you are ready to 
make a batch submission. Use the following procedure: 

1. Go to the Transaction menu and choose Batch. From the submenu (Fig­
ure 5-3.), select Run batch submission ... 

2. SubmitData will then ask you to choose a batch format and to enter the 
name of the data file. Type it in the box and select OK. 

3. Next, the application asks for the name of a file in which to save the 
transactions. The default name is the name of the data file plus the file 
extension transaction. Click on OK when you have chosen a file 
name. If you selected a file that already exists, the application will warn 



you. You can click on Yes to use it anyway and overwrite the old file. 
Click on No to give a different file name. 

4. SubmitData begins generating the new transactions. If you have a ses­
sion variable in the template, it will prompt you for its value. A Batch 
Transcript window opens_ up to show you the transactions as SubmitDa­
ta creates them (Figure 5-6.). When merging is complete, you will have 
the option to submit the transactions to the appropriate database. 
Whether or not you submit the transactions, the data will be saved in the 
file. You can view the file in a text editing program. . 

5. The batch transcript provides a report of the batch submission. You can 
save, print, or clear the transcript by selecting the appropriate button. 

D Batch Transcript 
Input file name ................. rr-uilfly 
Output filename ............. junk 
Transaction Template .. badDOG 

Total number of column variables .......................... 13 
Maximum column number: 16 

Total number of include variables .......................... 1 
Total number of reference variables ..................... 2 
Tota I number of procedure variables ..................... 1 
Total number of named variable references ........ 5 

' 

----------------------------------

Comment.text =The P1, from which this subclone is derived, is adjacent to P1 
(none). 
Entry.locus_name = DR01 ODC1 OZ 
Keyword.keyword = left elbow region 
Reference.hold_date = 23 March 1995 
Reference.title =Sequencing of the left elbow region of drosophila melanogaster -o 

El 
Figure 5-6. Batch transcript window. 
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Making a Dialog Submission 

For a dialog submission, as for a batch submission, you must make a template and 
a batch format. When you have made both of these, you are ready to run the dialog 
submission. 

Running the Dialog Submission 
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To run the dialog submission, use the following procedure: 

1. Pull down the File menu and select Batch. Choose Run dialog submission ... 
from the submenu (Figure 5-3.). Submit Data will ask you to choose from 
a list of batch files. 

2. Click on the one that you set up for the current batch of data. 
3. Next, the application will ask for the name of a file in which to save the 

transactions. The default name is the name of the data file plus the file 
extension transaction. Click on OK when you are satisfied with the 
file name. If you selected a file that already exists, the application will 
warn you of this. You can click on Yes to use it anyway and overwrite the 
old file. Click on No to type in a different file name. 

4. The next prompt that appears will be one of the prompts that you chose 
when you built your template. SubmitData will take you through the 
batch submission, transaction by transaction, prompting you for the 
data as it needs it (Figure 5-7.). 

5. At the end of each transaction, a dialog box will appear, allowing you tQ 
review the data for the last transaction and asking what you want to do 
next. Select Redo if you want to enter the data for the last transaction 
again (to make a correction). Click on Accept to add the data you just en­
tered to the submission file and begin entering data for the next transac­
tion. 

6. Enter the data for as many transactions as you want to make in this one 
batch. When you are done, click on Done in the dialog box to accept the 
last transaction and end the data entry. 

7. When SubmitData is done processing the information, it will give you 
the choice to submit the data or not. Whichever option you choose, the 
application will save the data under the file name you specified. 

8. As with a batch submission, SubmitData generates a batch transcript 
(Figure 5-6.). You can save, print, or clear the transcript by selecting the 
appropriate button. 



Enter a value for text in Comment? 

( OK B · ( Cancel ) 

Figure 5-7. A prompt in a dialog submission. 

Using Custom Batch Formats 

SubmitData can also operate with "custom batch formats." These are Smalltalk 
routines used to solve specific problems for certain users. H you face a submission 
problem that you believe SubmitData does not handle, you may consider building 
a custom format. For details, contact 

Manfred D. Zorn , 
Software Technologies and Applications Group 
Lawrence Berkeley Laboratory 

, University of California 
Berkeley, CA 94720 
E-mail: SubmitData@lbl.gov 
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Chapter 6 

Additional Features 

The Transaction menu has a submenu for loading different kinds of files into Sub­
mitData. You can edit saved transaction files, submit saved transactions, or update 
the application's forms. 

Saued transaction 

Submit saued transaction 

Update form definitions 

Figure 6-1. Load submenu. 

Editing a Saved Transaction 
/ 

/ 

If you wish, you can load a saved transaction into SubmitData to edit it. Select Load 
from the Transaction menu. In the submenu (Figure 6-1.), select Saved transaction . 

. A dialog box will appear, asking for a file name. Type the name of the saved trans­
action, then click on OK. The saved transaction becomes the current transaction, 

, which you can use as you would any valid transaction. For example, you might 
want to save the edited version under a different name to create a new transaction. 
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Submitting a Saved Transaction 

You can use the Load menu to quickly submit a saved transaction to a database. 
Select Load from the Transaction menu and choose Submit saved transaction ... from 
the Load submenu. SubmitData will prompt you for the name of the file and ask 
you to verify that you want to submit it. 

Updating Form Definitions 

Since genome databases often change their specifications for submissions, a func­
tion is provided to update SubmitData' s forms in accordance with those changes. 
The Update form definitions option in the Load submenu serves this purpose. Future 
updates will include instructions for using this function. 
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Chapter 7 

Database Modules 

SubmitData works with a number of database modules. Although they are similar 
overall, there are a few specific differences. The following pages describe the 
imique features of each module. As you receive new modules, you can insert the 
documentation for them in this chapter. 

41 



l.. 

···,; 

··~ 

'I 

42 

/ 



SubmitData \GSDB 
SubmitData \GSDB is the database module for the Genome Sequence database. A 
GSDB-specific help file is added to SubmitData when you install it. 

The GSDB Forms· 

The top-level form in SubmitData \GSDB is called "Entry." When you begin to fill 
in the GSDB forms, the words "Form: Entry" appear in the upper left-hand comer 
of the window. All other forms in this module are subforms that branch from the 
Entry form. 

:o Entry er 
Form: Entry ~ 

locus name • I 
division I Select 8 diuision: ~I 

molecule type I Select 8 molecule type: ~I 
definition I Select 8 definition: ~I 

number 0 I 
segments 0 I 

sequence ( sequence ) 
reference ( reference ) ' 
comment ( comment ) 
_keyword ( k:eyword ) 

~ 
Fill in at least the mandatory (bold) fields and press OK. 

0 ( Cancel ) ~ 

Figure GSDB-1 Top-level form for SubmitData \GSDB. 



Saued transaction 
Authorl n output 

Submit saued transaction 

Update form definitions 
Upgrade eHisting template 

Figure GSDB-2 Load submenu in SubmitData \GSDB. 

Loading AUTHORIN Output 

In SubmitData \GSDB, you can load data from the AUTHORIN database submis­
sion program into SubmitData. To do so, select Load from the Transaction menu 
(Figure GSDB-2) and choose Author In Output from the submenu. In the dialog box 
that appears, type the name of the AUTHORIN file and click on OK. The AU­
THORIN data is loaded as a SubmitData transaction. It becomes the current trans­
action, which you can use as you would any complete, valid transaction. 

The AUTHORIN software is available from: 

National Center for Biotechnology Information 
National Library of Medicine 
Bethesda, MD 

Upgrading Existing Templates 

This option lets you upgrade the templates already in SubmitData \GSDB to cor­
respond with the most current version of the module. You can reach it by selecting 
Load from the Transaction menu and choosing Upgrade existing template from the 
submenu. SubmitData \GSDB template upgrades will be distributed with instruc­
tions for using this function. 
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SubmitData \GDB 
SubmitData \GDB is the database module for the Genome database. The database 
module gives you a choice of data submission forms to match the type of data you 
wish to submit. A GDB-specific help file is added to SubmitData when you install . 
the SubmitData \GDB database module. 

Submission Button 

The leftmost button in the SubmitData \GDB module window is called Submission. 
Its function is essentially the same as that of the Transaction button in GSDB. All 
procedures that involve the Transaction button in GSDB are accomplished with the 
Submission button in GDB. 

Submissioll"' 

New transaction 
Edit template ... 

Batch 

Load > 

Preferences ... 

Figure GDB-1 Submission menu. 
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Data Submission Forms 

Since the SubmitData \ GDB module requires you to choose the type of submission, 
selecting New submission from the Submission menu presents a list of data submis­
sion forms. When you select one, the proper form will open in a new window. 
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Please choose a data s ubm iss ion form: 

Locus ~ 
Map 
Polymorphism 
Contig 
Cloned_probe 
Clo n ed_reagent 

cancel 

Figure GDB-2 GDB data submission form menu. 
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